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IsleVue Tarot-Zodiac-Element-Sephiroth Wheel of the Golden Dawn

Visio, SVG Document How To and Licensing Notes

This document will help you customize the “source” file, for the Zodiac/Elemental/Qabalah Wheel. If 
you have a copy of Visio (I used Visio 2016, but it appears that 2013 or higher should work) and a 
Spreadsheet program, you should be able to edit the Visio file. If not, you can still edit the scalable 
vector graphics (SVG) file.

Concept: External Data -- The Text is Stored in the Spreadsheet

There is just one key concept to know. All the text you see when you look at the SVG, with the excep-
tion of the “tool tips,” is stored in an Excel (XLS) file. You can change every bit of text, except the tool 
tips, by editing that file and pressing a button in Visio. But you have to make sure it all fits. More on 
that later.

First, the Excel file:

Notice that the top row and left column are frozen in place, and have a light gray background. That is 
a signal to you to NOT edit them. Visio is looking in those cells for IDs with which to identify the data. 
The contents of the Item column do not appear in the wheel. When you open that file, you’ll notice 
that to its right is another column called ItemName (not pictured above... it’s scrolled out of view. Right 
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now, evertying in the ItemName column exactly matches the Item column. Whatever you change in 
the ItemName column will update in Visio, so long as you don’t touch the Item column. In general, 
the ItemName is the first part of any shape. In the graphic above, you’ll see the names of the minor 
arcana.

Notice the other columns: Title, Meaning1 and Meaning2. In the Decan shaps, for example, we “build” 
the text you see by joining the columns. Take the 2 of Wands for example. We create text in this way:

 ♦ We start with the ItenName (2 of Wands)

 ♦ We add two blank space

 ♦ We add the contents of the Title column (Dominion -- this is the GD Esoteric name, not including 
“Lord of”)

 ♦ We add a carriage return

 ♦ We add the Meaning1 column (Harmony of rule, etc -- this is taken from the explanatory text of the 
GD)

 ♦ We add a carriage return

 ♦ We add the Meaning2 columng. This is a paraphrase of the GD cabalistic meaning

So as you can see, we build up the contents of each shape from the individual cells of the spread-
sheet. If you substitute too much text, you may run over the shap borders. You’ll have to either cut 
your text, or resize the font for that shape manually. But the key here is that if you’re careful, and keep 
all your words short, you’ll be able to customize the text in any way that you want. We’ll show you 
how to do that shortly.
 
The Visio Document

Visio makes it too easy to edit items by accident if they overlap. Therefore everything is arranged 
in layers. All the layers are protected. We recommeond you edit only one layer at a time. In Visio, 
shapes have a habit of ending up in multiple layers if you’re not careful.

The screen below shows the layers in this document. They were named carefully so as to be self 
explanatory:
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Data Refresh

Once you’ve edited and saved your Excel file, Open Visio, and go to the Data Tab. Press the Refresh 
External Data button. Most likely you’ll see an error stating that Visio can’t find the previously linked 
data file. That will because the folder name that you’ve placed it in on your machine will very likely be 
different than min. There’ll be a button to find the file and relink. Press that button, navigate through 
your files as necessary to find the right folder, then choose that file. If none of the “Titles” in Column A 
were changed, it should say “Complete” and all your data will update. it should look like this:
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Adding Additional Data or Changing Title Rows

If the Items in the Excel file don’t fit your needs, you’ll add new rows. For instance, we used the seven 
planets known to the Golden Dawn. You may wish to change the “duplicates” so that they incorporate 
Uranus, Neptune, etc. For those planets, by the way, there are already rows in the spreadsheet... 
they’re just not linked to Visio. But the concept applies. You’ll notice that when the External Data 
window pane is open, the data that is linked has a chain-link mark in the left column. Anything unused 
has no mark.

If you want to replace the “Item” in a shape, just unprotect its layer, click on it with the text tool, and 
delete. Then drag and drop your row into its place. Visio is smart enough to ask you if you want to 
replace the previous link. But it won’t display anything till you take another step after confirming you 
want to replace the link.

With that shape still selected, on the Insert tab, you’ll want to Insert a Field. You’ll be prompted to 
choose the columns from the spreadsheet. You can, for instance, just choose one. But if you recall, 
we explained before that in most cases, we’re “building” the text for most of those shapes by taking 
the contents of more than one cell in the row (called concatenation). If you wish to follow the format 
that we used, it will be very simply, because I’ll give you the concatentation formula by type of shape 
below. If you want to do something different, but still concatenate... you’ll have to look at my example, 
and figure out how to implement the variation you want.

In any case, the process of inserting that field will look like the screen shot below:
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As you can see, the row that is highlighted in the right hand pane (the external data) is being dropped 
into one of the “calendar” shapes. We’ve selected custom formula from the upper left hand list box, 
and then pasted in a formula in the edit box below it. It’s the type of formula we described above, in 
the section on concepts.

Here, then, are the text formulas used and where they’re used:

 ♦ Just the ItemName and Title (most of the outer wheels such as the Zodiac and cards; just the first 
two columns separated by a space character):  
=Prop._VisDM_ItemName&”  “&Prop._VisDM_Title

 ♦ The calendar/decan shapes and the minor arcana shapes (The Itemname, a carriage return, which 
is the CHAR(10) function, the title, which is usually just a symbol or a very short phrase, then the 
two meanings, with another carriage return between them): 
=Prop._VisDM_ItemName&CHAR(10)&Prop._VisDM_Title&” “&Prop._VisDM_
Meaning1&CHAR(10)&Prop._VisDM_Meaning2

 ♦ Kings, Queens, Knights (only the ItemName and first meaning, no carriage returns): 
=Prop._VisDM_ItemName&”  “&Prop._VisDM_Meaning1

 ♦ The Pages (same as the other court cards, but with a carriage return): 
=Prop._VisDM_ItemName&CHAR(10)&Prop._VisDM_Meaning1

The Tool Tips

Unfortunately, the tool tips, the little pop up text boxes you see when you hover over a shape in the 
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SVG file can’t be imported from an external data file... at least not in any way that I could find or 
search the web for. So, we kept those very simple. If you need to change them, unprotect your layer, 
select your shape, then go to the Developer tab, and press the Shape Name button. It’s the first high-
lighted box there. If you don’t have a Developer tab visible, go to your Visio preferences to enable it.

Export to Different Formats

If you wish to export your Visio file to SVG or other formats, open the File tab, choose Save As, then 
select for format. There is an Export to PDF command, but the Microsoft export generally leaves a bit 
to be desired... you’re on your own there. But there are so many alternatives, you’ll be able to get the 
file in the destination format you wish, I’m sure.

Editing the SVG Directly

If you don’t have a copy of Visio, you can edit the SVG file with Adobe Illustrator or Inkscape, which is 
free. Neither is particularly easy to use, but where there’s a will, there’s a way.

License

You probably already know the Visio file is provided to you as per the Creative Commons 4.0 Attribu-
tion license. If you use the graphic as is, you attribute it to www.islevue.com, and link there if you’re 
publishing on the web. Note that almost all the text, with the exception of the Qabalistic summaries, 
was copied/pasted from the original Golden Dawn materials, so if you’re just quoting text, you should 
be able to do just about anything you want. But the text editing and graphic together represent quite 
a lot of hours of work, so we expect you to treat this work with respect and follow the rules for attribu-
tion.

We encourage you to create a derivative work. By derivative, we mean with real changes to sub-
stance, not just changing fonts or colors. We encourage you to, in turn, put your derivative work under 
a similar license, but that’s up to you. 

Needless to say, this work... the Visio file, this document, the SVG file, and any other formats that we 
provide... is provided as is with no warranty, no liability.

Here is the “human readable” summary of the Creative Commons license, followed by the full license 
text:

This is a human-readable summary of (and not a substitute for) the license. Disclaimer.
You are free to:

 ♦     Share — copy and redistribute the material in any medium or format

 ♦     Adapt — remix, transform, and build upon the material

 ♦     for any purpose, even commercially.

This license is acceptable for Free Cultural Works.

 ♦     The licensor cannot revoke these freedoms as long as you follow the license terms.
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Under the following terms:

 ♦ Attribution — You must give appropriate credit, provide a link to the license, and indicate if changes 
were made. You may do so in any reasonable manner, but not in any way that suggests the 
licensor endorses you or your use.

 ♦ No additional restrictions — You may not apply legal terms or technological measures that legally 
restrict others from doing anything the license permits.

Notices:

 ♦ You do not have to comply with the license for elements of the material in the public domain or 
where your use is permitted by an applicable exception or limitation.

 ♦ No warranties are given. The license may not give you all of the permissions necessary for your 
intended use. For example, other rights such as publicity, privacy, or moral rights may limit how you 
use the material.

Full License 

Creative Commons Corporation (“Creative Commons”) is not a law firm and does not provide legal 
services or legal advice. Distribution of Creative Commons public licenses does not create a lawyer-
client or other relationship. Creative Commons makes its licenses and related information available 
on an “as-is” basis. Creative Commons gives no warranties regarding its licenses, any material li-
censed under their terms and conditions, or any related information. Creative Commons disclaims all 
liability for damages resulting from their use to the fullest extent possible.

Using Creative Commons Public Licenses

Creative Commons public licenses provide a standard set of terms and conditions that creators and 
other rights holders may use to share original works of authorship and other material subject to copy-
right and certain other rights specified in the public license below. The following considerations are for 
informational purposes only, are not exhaustive, and do not form part of our licenses.

Considerations for licensors: Our public licenses are intended for use by those authorized to give the 
public permission to use material in ways otherwise restricted by copyright and certain other rights. 
Our licenses are irrevocable. Licensors should read and understand the terms and conditions of the 
license they choose before applying it. Licensors should also secure all rights necessary before ap-
plying our licenses so that the public can reuse the material as expected. Licensors should clearly 
mark any material not subject to the license. This includes other CC-licensed material, or material 
used under an exception or limitation to copyright. More considerations for licensors.

Considerations for the public: By using one of our public licenses, a licensor grants the public permis-
sion to use the licensed material under specified terms and conditions. If the licensor’s permission 
is not necessary for any reason–for example, because of any applicable exception or limitation to 
copyright–then that use is not regulated by the license. Our licenses grant only permissions under 
copyright and certain other rights that a licensor has authority to grant. Use of the licensed material 
may still be restricted for other reasons, including because others have copyright or other rights in the 
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material. A licensor may make special requests, such as asking that all changes be marked or de-
scribed. Although not required by our licenses, you are encouraged to respect those requests where 
reasonable. More considerations for the public.
Creative Commons Attribution 4.0 International Public License

By exercising the Licensed Rights (defined below), You accept and agree to be bound by the terms 
and conditions of this Creative Commons Attribution 4.0 International Public License (“Public Li-
cense”). To the extent this Public License may be interpreted as a contract, You are granted the 
Licensed Rights in consideration of Your acceptance of these terms and conditions, and the Licensor 
grants You such rights in consideration of benefits the Licensor receives from making the Licensed 
Material available under these terms and conditions.

Section 1 – Definitions.

    Adapted Material means material subject to Copyright and Similar Rights that is derived from or 
based upon the Licensed Material and in which the Licensed Material is translated, altered, arranged, 
transformed, or otherwise modified in a manner requiring permission under the Copyright and Simi-
lar Rights held by the Licensor. For purposes of this Public License, where the Licensed Material is 
a musical work, performance, or sound recording, Adapted Material is always produced where the 
Licensed Material is synched in timed relation with a moving image.
    Adapter’s License means the license You apply to Your Copyright and Similar Rights in Your contri-
butions to Adapted Material in accordance with the terms and conditions of this Public License.
    Copyright and Similar Rights means copyright and/or similar rights closely related to copyright 
including, without limitation, performance, broadcast, sound recording, and Sui Generis Database 
Rights, without regard to how the rights are labeled or categorized. For purposes of this Public Li-
cense, the rights specified in Section 2(b)(1)-(2) are not Copyright and Similar Rights.
    Effective Technological Measures means those measures that, in the absence of proper author-
ity, may not be circumvented under laws fulfilling obligations under Article 11 of the WIPO Copyright 
Treaty adopted on December 20, 1996, and/or similar international agreements.
    Exceptions and Limitations means fair use, fair dealing, and/or any other exception or limitation to 
Copyright and Similar Rights that applies to Your use of the Licensed Material.
    Licensed Material means the artistic or literary work, database, or other material to which the Licen-
sor applied this Public License.
    Licensed Rights means the rights granted to You subject to the terms and conditions of this Public 
License, which are limited to all Copyright and Similar Rights that apply to Your use of the Licensed 
Material and that the Licensor has authority to license.
    Licensor means the individual(s) or entity(ies) granting rights under this Public License.
    Share means to provide material to the public by any means or process that requires permission 
under the Licensed Rights, such as reproduction, public display, public performance, distribution, 
dissemination, communication, or importation, and to make material available to the public including 
in ways that members of the public may access the material from a place and at a time individually 
chosen by them.
    Sui Generis Database Rights means rights other than copyright resulting from Directive 96/9/EC of 
the European Parliament and of the Council of 11 March 1996 on the legal protection of databases, 
as amended and/or succeeded, as well as other essentially equivalent rights anywhere in the world.
    You means the individual or entity exercising the Licensed Rights under this Public License. Your 
has a corresponding meaning.

Section 2 – Scope.
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    License grant.
        Subject to the terms and conditions of this Public License, the Licensor hereby grants You a 
worldwide, royalty-free, non-sublicensable, non-exclusive, irrevocable license to exercise the Li-
censed Rights in the Licensed Material to:
            reproduce and Share the Licensed Material, in whole or in part; and
            produce, reproduce, and Share Adapted Material.
        Exceptions and Limitations. For the avoidance of doubt, where Exceptions and Limitations apply 
to Your use, this Public License does not apply, and You do not need to comply with its terms and 
conditions.
        Term. The term of this Public License is specified in Section 6(a).
        Media and formats; technical modifications allowed. The Licensor authorizes You to exercise 
the Licensed Rights in all media and formats whether now known or hereafter created, and to make 
technical modifications necessary to do so. The Licensor waives and/or agrees not to assert any right 
or authority to forbid You from making technical modifications necessary to exercise the Licensed 
Rights, including technical modifications necessary to circumvent Effective Technological Measures. 
For purposes of this Public License, simply making modifications authorized by this Section 2(a)(4) 
never produces Adapted Material.
        Downstream recipients.
            Offer from the Licensor – Licensed Material. Every recipient of the Licensed Material automati-
cally receives an offer from the Licensor to exercise the Licensed Rights under the terms and condi-
tions of this Public License.
            No downstream restrictions. You may not offer or impose any additional or different terms or 
conditions on, or apply any Effective Technological Measures to, the Licensed Material if doing so 
restricts exercise of the Licensed Rights by any recipient of the Licensed Material.
        No endorsement. Nothing in this Public License constitutes or may be construed as permission 
to assert or imply that You are, or that Your use of the Licensed Material is, connected with, or spon-
sored, endorsed, or granted official status by, the Licensor or others designated to receive attribution 
as provided in Section 3(a)(1)(A)(i).

    Other rights.
        Moral rights, such as the right of integrity, are not licensed under this Public License, nor are 
publicity, privacy, and/or other similar personality rights; however, to the extent possible, the Licensor 
waives and/or agrees not to assert any such rights held by the Licensor to the limited extent neces-
sary to allow You to exercise the Licensed Rights, but not otherwise.
        Patent and trademark rights are not licensed under this Public License.
        To the extent possible, the Licensor waives any right to collect royalties from You for the exercise 
of the Licensed Rights, whether directly or through a collecting society under any voluntary or waiv-
able statutory or compulsory licensing scheme. In all other cases the Licensor expressly reserves any 
right to collect such royalties.

Section 3 – License Conditions.

Your exercise of the Licensed Rights is expressly made subject to the following conditions.

    Attribution.

        If You Share the Licensed Material (including in modified form), You must:
            retain the following if it is supplied by the Licensor with the Licensed Material:
                identification of the creator(s) of the Licensed Material and any others designated to receive 
attribution, in any reasonable manner requested by the Licensor (including by pseudonym if desig-
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nated);
                a copyright notice;
                a notice that refers to this Public License;
                a notice that refers to the disclaimer of warranties;
                a URI or hyperlink to the Licensed Material to the extent reasonably practicable;
            indicate if You modified the Licensed Material and retain an indication of any previous modifi-
cations; and
            indicate the Licensed Material is licensed under this Public License, and include the text of, or 
the URI or hyperlink to, this Public License.
        You may satisfy the conditions in Section 3(a)(1) in any reasonable manner based on the me-
dium, means, and context in which You Share the Licensed Material. For example, it may be reason-
able to satisfy the conditions by providing a URI or hyperlink to a resource that includes the required 
information.
        If requested by the Licensor, You must remove any of the information required by Section 3(a)(1)
(A) to the extent reasonably practicable.
        If You Share Adapted Material You produce, the Adapter’s License You apply must not prevent 
recipients of the Adapted Material from complying with this Public License.

Section 4 – Sui Generis Database Rights.

Where the Licensed Rights include Sui Generis Database Rights that apply to Your use of the Li-
censed Material:

    for the avoidance of doubt, Section 2(a)(1) grants You the right to extract, reuse, reproduce, and 
Share all or a substantial portion of the contents of the database;
    if You include all or a substantial portion of the database contents in a database in which You have 
Sui Generis Database Rights, then the database in which You have Sui Generis Database Rights (but 
not its individual contents) is Adapted Material; and
    You must comply with the conditions in Section 3(a) if You Share all or a substantial portion of the 
contents of the database.

For the avoidance of doubt, this Section 4 supplements and does not replace Your obligations under 
this Public License where the Licensed Rights include other Copyright and Similar Rights.

Section 5 – Disclaimer of Warranties and Limitation of Liability.

    Unless otherwise separately undertaken by the Licensor, to the extent possible, the Licensor offers 
the Licensed Material as-is and as-available, and makes no representations or warranties of any kind 
concerning the Licensed Material, whether express, implied, statutory, or other. This includes, with-
out limitation, warranties of title, merchantability, fitness for a particular purpose, non-infringement, 
absence of latent or other defects, accuracy, or the presence or absence of errors, whether or not 
known or discoverable. Where disclaimers of warranties are not allowed in full or in part, this disclaim-
er may not apply to You.
    To the extent possible, in no event will the Licensor be liable to You on any legal theory (including, 
without limitation, negligence) or otherwise for any direct, special, indirect, incidental, consequential, 
punitive, exemplary, or other losses, costs, expenses, or damages arising out of this Public License or 
use of the Licensed Material, even if the Licensor has been advised of the possibility of such losses, 
costs, expenses, or damages. Where a limitation of liability is not allowed in full or in part, this limita-
tion may not apply to You.
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    The disclaimer of warranties and limitation of liability provided above shall be interpreted in a man-
ner that, to the extent possible, most closely approximates an absolute disclaimer and waiver of all 
liability.

Section 6 – Term and Termination.

    This Public License applies for the term of the Copyright and Similar Rights licensed here. How-
ever, if You fail to comply with this Public License, then Your rights under this Public License terminate 
automatically.

    Where Your right to use the Licensed Material has terminated under Section 6(a), it reinstates:
        automatically as of the date the violation is cured, provided it is cured within 30 days of Your 
discovery of the violation; or
        upon express reinstatement by the Licensor.
    For the avoidance of doubt, this Section 6(b) does not affect any right the Licensor may have to 
seek remedies for Your violations of this Public License.
    For the avoidance of doubt, the Licensor may also offer the Licensed Material under separate 
terms or conditions or stop distributing the Licensed Material at any time; however, doing so will not 
terminate this Public License.
    Sections 1, 5, 6, 7, and 8 survive termination of this Public License.

Section 7 – Other Terms and Conditions.

    The Licensor shall not be bound by any additional or different terms or conditions communicated by 
You unless expressly agreed.
    Any arrangements, understandings, or agreements regarding the Licensed Material not stated 
herein are separate from and independent of the terms and conditions of this Public License.

Section 8 – Interpretation.

    For the avoidance of doubt, this Public License does not, and shall not be interpreted to, reduce, 
limit, restrict, or impose conditions on any use of the Licensed Material that could lawfully be made 
without permission under this Public License.
    To the extent possible, if any provision of this Public License is deemed unenforceable, it shall be 
automatically reformed to the minimum extent necessary to make it enforceable. If the provision can-
not be reformed, it shall be severed from this Public License without affecting the enforceability of the 
remaining terms and conditions.
    No term or condition of this Public License will be waived and no failure to comply consented to un-
less expressly agreed to by the Licensor.
    Nothing in this Public License constitutes or may be interpreted as a limitation upon, or waiver of, 
any privileges and immunities that apply to the Licensor or You, including from the legal processes of 
any jurisdiction or authority.

Creative Commons is not a party to its public licenses. Notwithstanding, Creative Commons may 
elect to apply one of its public licenses to material it publishes and in those instances will be consid-
ered the “Licensor.” The text of the Creative Commons public licenses is dedicated to the public do-
main under the CC0 Public Domain Dedication. Except for the limited purpose of indicating that mate-
rial is shared under a Creative Commons public license or as otherwise permitted by the Creative 
Commons policies published at creativecommons.org/policies, Creative Commons does not authorize 
the use of the trademark “Creative Commons” or any other trademark or logo of Creative Commons 
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without its prior written consent including, without limitation, in connection with any unauthorized 
modifications to any of its public licenses or any other arrangements, understandings, or agreements 
concerning use of licensed material. For the avoidance of doubt, this paragraph does not form part of 
the public licenses.

Creative Commons may be contacted at creativecommons.org.


